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Ia PARTE – Principali caratteristiche e modalità di utilizzo del Vector Digitizer 
 

Introduzione 
Nonostante la sempre crescente disponibilità di dati digitalizzati utilizzabili direttamente in GRASS, la digitalizzazione da 

base cartografica e l'editing di carte vettoriali esistenti rimangono aspetti fondamentali nella costruzione di un database, sia 

per la qualità che per la quantità delle operazioni che condizionano l'affidabilità dei dati e i tempi di esecuzione. 

In GRASS è disponibile uno strumento estremamente efficiente per l'acquisizione e l'editing dei dati vettoriali: il Vector 

Digitizer, un modulo con interfaccia grafica che rende disponibile un'ampia gamma di funzioni ad accesso rapido e 

intuitivo.  

Per l’uso del presente manuale, prerequisito indispensabile è ovviamente la conoscenza di GRASS, almeno ad un livello 

elementare. 

Ovviamente ogni commento, suggerimento o segnalazione di errori e incongruenze risulterà estremamente gradito e 

contribuirà al miglioramento delle prossime edizioni. 

 

Operazioni preliminari 
Per sperimentare i vari comandi del Vector Digitizer (d’ora in poi VD) è stata costruita una Location, denominata 

Appennino, con il sistema di coordinate UTM ED50 Zona 32 e una regione di default con un’estensione di 600x600m. 

Avendo adottato una risoluzione di 1m, l'area risulta pertanto coperta da 600x600 celle.  

Si entri quindi in GRASS selezionando la Location Appennino e il Mapset valparma. 

 

 
 

Nel Mapset PERMANENT sono presenti: 

una carta raster denominata topografia; 

una carta vettoriale denominata provadig. 

Nel Mapset valparma è presente: 

una copia della carta vettoriale provadig denominata provadig1. 

 
Il contenuto dei due Mapset può essere verificato tramite il comando g.list accessibile dal Layer Manager (d’ora in poi 

LM): 

File > Manage maps > List  [g.list] 
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Nel sottopannello Command output viene visualizzato il contenuto dei Mapset. 
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Per visualizzare le caratteristiche della regione di default: 

 

Settings > Region > Display region [g.region –p] 
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Se la regione corrente non risultasse quella di default, si imposti la regione di default come regione corrente mediante: 

 

Settings > Region > Set region [g.region] 

 

Nel pannello si attivi l’opzione Set from default region e si clicchi Run, quindi Chiudi. 
 

 
  



 

6 

 

Le carte vettoriali in GRASS 
Come noto, in GRASS una carta vettoriale è costituita da un insieme di caratteristiche geometriche ed eventualmente di 

attributi. 

La geometria è salvata in uno specifico formato vettoriale di GRASS (formato nativo), mentre gli attributi sono salvati in 

table (o tavole degli attributi) all’interno di un database e collegati alle caratteristiche geometriche mediante una DBMI 

(DataBase Management Interface). La geometria di un oggetto, riproducibile mediante le forme geometriche elementari 

punto, linea e poligono, è riconducibile ad una delle cinque tipologie seguenti: 

Point (punto): per rappresentare gli elementi puntiformi (punti quotati, pozzi, ecc.). Ogni punto è rappresentato 

da una coppia di coordinate. 

Line (linea): per rappresentare elementi lineari (strade, fiumi, linee elettriche, ecc.). Ogni linea è costituita da 

una spezzata. I due punti alle estremità della spezzata sono definiti nodi, mentre i punti intermedi sono definiti vertici. Ogni 

linea viene memorizzata mediante una sequenza di coppie di coordinate in corrispondenza dei nodi e dei vertici 

della spezzata. 

Boundary (bordo di area): per rappresentare, anche parzialmente, i bordi di aree chiuse (laghi, piante di edifici, 

appezzamenti di terreno, ecc.). E’ una spezzata memorizzata mediante una sequenza di coppie di coordinate in 

corrispondenza dei nodi e dei vertici. 

Centroid (centroide). E’ un elemento puntiforme all’interno di un’area chiusa in corrispondenza del quale 

vengono inseriti gli attributi dell’area. Ogni centroide è rappresentato da una coppia di coordinate. 

Area (area). E’ l’insieme di un bordo di area (boundary) completo, vale a dire chiuso, e del relativo centroide (centroid). 

 

Una table è costituita da un insieme di colonne, ciascuna delle quali rappresenta un attributo, e da tante righe quante sono le 

categorie presenti nella carta. La connessione fra ciascun oggetto vettoriale (punto, linea, centroide) nel file della geometria 

ed i suoi attributi nella table è effettuato tramite il numero di categoria (cat):       

 

          File della geometria       table (tavola degli attributi) 

  cat       coordinate     cat           attributo1 attributo2       ….…. 

     1    x,y,x,y,……….     1     33     nomeA 

     4    x,y,x,y,……….     2        215     nomeB 

        4    x,y,x,y,……….         3     28     nomeC   

       2    x,y,x,y,……….          4        12     nomeD 

       1    x,y,x,y,……….          5          33     nomeE 

    5    x,y,x,y,……….       

     3    x,y,x,y,……….       

 
E’ anche possibile, mediante l’utilizzo dei cosiddetti layer, connettere gli oggetti contenuti nel file della geometria a più 

table con attributi diversi. La connessione fra un oggetto nel file della geometria ed uno specifico attributo di una table, 

avviene attraverso il numero di categoria (cat), secondo il seguente schema (si noti che uno stesso oggetto può essere 

attribuito contemporaneamente a diversi layer, come ad es. il primo dell’elenco, che è collegato alla table A tramite il 

layer1, e alla table B tramite il layer2): 

 

 

File della geometria  

layer 1 

cat 

layer 2 

cat 
coordinate  

2 3 x,y x,y ….. table A (connessa al layer 1) 

1  x,y x,y …..  cat Attributo 1 Attributo 2 ……….. 

 1 x,y x,y …..  1 Nome A ……….. ……….. 

1  x,y x,y …..  2 Nome B ……….. ……….. 

1 3 x,y x,y …..  3 Nome C ……….. ……….. 

 2 x,y x,y …..  

 1 x,y x,y ….. table B  (connessa al layer 2) 

3 4 x,y x,y …..  cat Attributo 1 Attributo 2 ……….. 

2  x,y x,y …..  1 Nome A ……….. ……….. 

2  x,y x,y …..  2 Nome B ……….. ……….. 

 4 x,y x,y …..  3 Nome C ……….. ……….. 

……  ………..  4 Nome D ……….. ……….. 
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Attivazione del Vector Digitizer 
Prima di proseguire, si imposti l’area di visualizzazione del Map Display (d’ora in poi MD) coincidente con la regione di 

default mediante il tasto  (Various zoom options) e l’opzione Zoom to default region. 
 

 
 

 

Per accedere all’ambiente di digitalizzazione sono disponibili diverse modalità.  

 

a) Se si intende modificare una carta esistente, si inserisca la carta, ad es. provadig1, nel LM. La carta viene ovviamente 

visualizzata nel MD. 

 

     

Per attivare il VD si clicchi nel LM il primo tasto della seconda fila (Edit selected vector map). L’ambiente di lavoro del 

MD viene modificato da 2D view a Digitize, come riportato nella finestra in alto a destra. Nella finestra sulla sinistra viene 

riportato il nome della carta inserita (provadig1) che viene visualizzata in forma modificabile nel MD. Viene inoltre 

inserita una riga contenente i 18 tasti funzionali del VD. 
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Se l’accesso al VD secondo questa modalità richiede la definizione di una carta esistente nel LM, è tuttavia possibile, 

dall’interno del VD, sostituire la carta da editare mediante la finestra in alto a sinistra. Cliccando infatti la freccia alla destra 

del nome della carta, viene aperto un menu con l’opzione New vector map. Con un clic sull’opzione si apre un pannello in 

cui è possibile definire la carta, nuova o già presente nel Mapset corrente, da sostituire alla carta attuale. 

 

                    
 
Si clicchi il tasto Annulla per chiudere il pannello dell’opzione. 

Per uscire dal VD si clicchi sull’ultima tasto della seconda fila  (Quit digitizer). Va considerato che è questa l’unica 

modalità corretta per uscire dal VD, in quanto prima dell’uscita viene creato il file della topologia che è uno dei file 

necessari per una definizione completa della carta. Ogni altra modalità di uscita rende necessaria la successiva costruzione 

del file della topologia mediante l’apposito comando v.build (Vector > Topology maintenance > Create or rebuild topology 
[v.build]). 

 

b) In alternativa all’utilizzo del tasto  (Edit selected vector map) si può utilizzare l’opzione  Start editing del menu che 

viene aperto con un clic col tasto destro sul nome della carta nel LM. 
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Si ottiene esattamente lo stesso risultato della modalità precedente. Si clicchi sul tasto  (Quit digitizer) per uscire dal VD. 

Si disattivi la visualizzazione della carta provadig1 nel LM. 

 
c) Se si intende creare una nuova carta, vale a dire una carta il cui nome non è presente nel Mapset corrente e non può 

quindi essere inserito nel LM, risulta più conveniente selezionare nel MD la modalità Digitize nel menu della finestra in 

alto a destra. 

 

 
 

E successivamente cliccare New vector map nella finestra sulla sinistra. 

 

 
 

Il nome della nuova carta, ad es. carta_nuova, deve essere digitato nel pannello che viene aperto. 

 

            
 

Si disattivi l’opzione Create attribute table per evitare l’apertura della tavola degli attributi, e si clicchi OK. La carta viene 

creata e si ottiene lo stesso risultato delle due procedure precedenti. Ovviamente il MD appare bianco essendo la carta 

creata priva di contenuti. Si esca dal VD con l’ultimo tasto della seconda fila  (Quit digitizer). 
 

L’ambiente di digitalizzazione può anche essere aperto dal prompt di GRASS  nel terminale a caratteri digitando il 

comando g.gui.vdigit seguito dal nome della carta (il nome della carta può anche essere specificato successivamente). Si 

digiti ad es.: 

> g.gui.vdigit provadig1 

Si apre il consueto ambiente di digitalizzazione. Si esca col solito tasto  e si chiuda anche la finestra che riporta la 

costruzione del file della topologia. 
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Modalità di digitalizzazione 
Vengono di seguito descritte le modalità di digitalizzazione delle diverse tipologie di elementi di una carta vettoriale. 

I tasti del mouse hanno le seguenti funzioni: 

il tasto sinistro seleziona o deseleziona un elemento; 

il tasto destro esegue l’operazione; 

il tasto ctrl (della tastiera) + il tasto sinistro (del mouse) cancella l’operazione o cancella progressivamente all’indietro i 

vertici durante la digitalizzazione di una linea; 

la rotellina in avanti effettua l’ingrandimento dell’immagine, all’indietro una riduzione; 

un clic sulla rotellina comporta lo spostamento dell’immagine (pan) con riposizionamento del punto selezionato al centro 

del MD. 

Va tenuto presente che oltre alle funzioni dei tasti specifici del VD presenti nella seconda riga, sono anche utilizzabili le 

funzioni dei tasti della prima riga del MD. 

 

Digitalizzazione di punti 

Si supponga di dover creare una carta vettoriale contenente un certo numero di pozzi, rappresentati da elementi puntiformi, 

nell’area definita dalla regione di default. Ciascun pozzo, oltre che da un numero progressivo, si prevede debba essere 

caratterizzato da un numero identificativo desunto da un inventario preesistente, dal nome del proprietario e dalla 

profondità raggiunta.  

Si entri in GRASS con la Location Appennino e il Mapset valparma, e nel VD mediante una delle modalità descritte in 

precedenza, ad es. selezionando l’ambiente Digitize nella finestra in alto a destra del MD, l’opzione New vector map nella 

finestra sulla sinistra, e inserendo il nome della nuova carta, pozzi, nel pannello che viene aperto. Quindi OK. 

 

 
 

 
 

Viene aperto il pannello con il contenuto della tavola degli attributi della nuova carta. Alla table viene assegnato 

automaticamente lo stesso nome della carta (ma è ovviamente possibile assegnare un nome diverso). 
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Risulta presente solo la colonna, denominata cat, contenente il numero di categoria, di tipo integer, inserita di default, e 

vanno pertanto inserite le tre colonne destinate a contenere, nell’ordine, il numero del pozzo in un inventario preesistente, 

da denominare Inventario, il nome del proprietario, da denominare Proprieta (senza accento, in quanto lettere accentate 

non sono consentite) e la profondità del pozzo, con l’intestazione Profondita. 

Si inserisca pertanto nella sezione Add column il nome Inventario in Column. Di default la variabile viene definita di tipo 

integer, come riportato nella casella più a destra. Dal momento che il numero d’inventario è effettivamente un numero 

intero, non è necessario apportare alcuna modifica. La variabile Length non necessita di essere definita in quanto 

automaticamente assunta uguale a 20 sia per le variabili di tipo integer  che double. 

 

 
  

Con un clic sul tasto Add la nuova colonna viene inserita nella tavola degli attributi. 
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Si inserisca quindi il nome della colonna successiva Proprieta. La nuova colonna è destinata a contenere il nome del 

proprietario, vale a dire dei caratteri alfanumerici, per cui nello spazio più a destra si selezioni, cliccando sulla freccia, 

varchar come tipo di variabile e nello spazio successivo si inserisca 50 come numero massimo di caratteri che possono 

essere utilizzati per definire la variabile. 

 

 
 

Di nuovo Add per inserire la nuova colonna. 
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Infine si inserisca la colonna Profondita e si selezioni double come tipo di variabile, dal momento che i valori di 

profondità verranno espressi in metri con una cifra decimale.  

 

 
 

Con un clic su Add la nuova colonna viene inserita e la tavola degli attributi, denominata pozzi, risulta completata. 
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Si clicchi Chiudi. 
 

Dal momento che si intende effettuare la digitalizzazione all’interno dell’area definita dalla regione di default, è utile far 

coincidere l’area di visualizzazione con tale regione cliccando il tasto (Various zoom options) nel MD e selezionando 

l’opzione Zoom to default region.  

 

 
 

Considerando inoltre che le dimensioni e la forma di tale regione non corrispondono a quelle del MD, risulta opportuno 

visualizzare nel MD la cornice che delimita la regione di default tramite l’opzione Show comp. extent nella cornice 

inferiore del MD. 
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Il numero di categoria assegnato ai punti che verranno digitalizzati dipende dall’impostazione presente nel pannello 

Attributes accessibile tramite il tasto   (Digitization setting) del MD (non del LM!). Sono disponibili tre modalità di 

assegnazione del numero di categoria, visualizzabili mediante la freccia in corrispondenza di Category mode. 

 

 
 

L’opzione No category comporta la non assegnazione di un numero di categoria (e conseguentemente la non apertura del 

pannello per l’assegnazione degli attributi all’elemento digitalizzato). 

La modalità Next to use incrementa automaticamente il numero di categoria per ogni elemento digitalizzato. Manual entry 

consente l’inserimento del numero di categoria da parte dell’utente. Si imposti l’opzione Manual entry che consente un 

maggior controllo da parte dell’utente. Dal momento che si intende assegnare ai punti digitalizzati un numero progressivo, 

si verifichi che il numero di categoria impostato sia 1. Si attivi l’opzione Add new record into table, si clicchi Applica e si 

lasci il pannello aperto e quindi disponibile per le successive modifiche. 
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Per digitalizzare il primo pozzo si clicchi il tasto  (Digitize new point) (che assume uno sfondo azzurro), quindi si 

posizioni il cursore (che assume la forma di una crocetta) in un punto qualsiasi del MD (che si suppone sia la posizione del 

pozzo) e si clicchi il tasto sinistro del mouse. Nel punto individuato viene tracciata una crocetta. 

 

 
 

e viene aperto il pannello per la definizione degli attributi del pozzo.  

Si noti che a Category (il numero di categoria) risulta assegnato il valore 1.  

Nel pannello si digiti in Inventario il numero 12, in Proprieta il nome Rossi Mario e in Profondita il valore 66.3.  

Quindi il tasto Submit nella cornice inferiore. 
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Il pannello viene chiuso.  

Prima di digitalizzare il secondo punto, si incrementi a 2 il numero di categoria nel pannello Attributes e si clicchi Applica. 

 

 
 

Si individui un altro punto all’interno dell’area di digitalizzazione, si clicchi il tasto sinistro del mouse e si ripeta 

l’operazione di inserimento degli attributi nel pannello che viene aperto. Si immettano i valori 14, Bianchi Giuseppe e 78.8 

per le tre variabili. Quindi Submit. 
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Si inserisca la categoria 3 in Attributes e si digitalizzi un terzo punto, con gli attributi 22, Verdi Paolo e 122.3.  

 

            
 

Ai tre punti finora digitalizzati è stato assegnato un numero di categoria progressivo, ma è ovviamente possibile, con 

l’opzione Manual entry, assegnare un qualunque valore di categoria all’elemento digitalizzato. Si digiti ad es. 22 in 

Category number. Quindi Applica. 
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Si digitalizzi un nuovo punto e nel pannello degli attributi che viene aperto, che riporta la categoria 22, si inseriscano 36, 

Neri Pietro e 55.5, quindi Submit. 
 

 
 

Il MD dovrebbe avere un aspetto simile al seguente. 

 

 
 

Si chiuda il sottopannello Attributes. 
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Si esca dalla funzione di digitalizzazione dei punti cliccando il tasto   (Pointer), il quarto della prima fila.  

 

 
 

Per uscire dal VD salvando la carta digitalizzata si clicchi il tasto  (Quit digitizing tool)  e si clicchi Si nel pannello di 

conferma. 
 

 
 

Per visualizzare la carta creata, il cui nome è già inserito nel LM, si disattivi e si riattivi la sua visualizzazione tramite la 

casella di spunta alla sinistra del nome della carta. Attivando l’opzione di visualizzazione dei numeri di categoria, si 

dovrebbe ottenere un risultato simile al seguente. 

 

 
 

Mentre la tavola degli attributi può essere visualizzata con l’opzione Show attribute data del menu che viene aperto con un 

clic del tasto destro sul nome della carta. 
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Si chiuda la tavola degli attributi. Si disattivi, o si rimuova, la carta pozzi nel LM. 

 
 

Digitalizzazione di linee 

Per sperimentare la digitalizzazione di elementi lineari, si apra il VD con la modalità utilizzata in precedenza assegnando il 

nome linee alla carta da creare. 

 

 
 

 
 

Supponendo di dover assegnare un solo attributo a ciascuna linea digitalizzata, nella table si inserisca la sola variabile 

Nome, di tipo varchar e con una lunghezza di 15. Quindi Add. 
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E Chiudi. 
 

 
 

Nel pannello Attributes, che come già sperimentato in precedenza è accessibile tramite il tasto  (Digitization settings) nel 

MD, si imposti Manual entry, si assegni 1 a Category number e si attivi l’opzione Add new record into table. 
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Per digitalizzare la prima linea si clicchi il tasto   (Digitize new line) (che assume lo sfondo azzurro). Si posizioni il 

mouse in un punto qualsiasi all’interno del monitor e si clicchi il tasto sinistro. Viene digitalizzato il punto iniziale della 

linea (nodo). Si sposti il mouse in un'altra posizione e si clicchi di nuovo il tasto sinistro per digitalizzare il secondo punto 

(vertice). Si proceda allo stesso modo per acquisire altri vertici.  

Per terminare la digitalizzazione della linea, si prema il tasto destro. I due nodi vengono evidenziati mediante delle crocette 

rosse e compare la finestra per l’immissione degli attributi.  

 

 
 

In corrispondenza dell’unico attributo previsto si immetta Linea A, e si clicchi il tasto Submit. 
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Per digitalizzare una seconda linea, in Attributes si assegni 2 come Category number. 
 

 
 

Quindi si digitalizzi la linea seguendo la procedura precedente e si attribuisca la denominazione Linea B. 

 

 
 

Dopo aver inserito 3 come Category number in Attributes, si digitalizzi una terza linea. 
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Per sperimentare la cancellazione di vertici durante la fase di digitalizzazione della linea, dopo aver digitalizzato alcuni 

vertici si tenga premuto il tasto ctrl (control): ad ogni clic del tasto sinistro del mouse viene cancellato un vertice 

precedentemente digitalizzato. Dopo aver cancellato alcuni vertici si chiuda la linea e nel pannello degli attributi si 

inserisca la denominazione Linea C. 

 

 
 

Si esca dalla funzione di digitalizzazione delle linee (tasto   ) e dal VD (tasto ), rispondendo affermativamente alla 

richiesta nel pannello che viene aperto. 

 

 
 

La visualizzazione nel MD della carta con le categorie, dovrebbe dare un risultato analogo al seguente.  
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E la seguente tavola degli attributi. 

 

 
 

Si chiuda la tavola degli attributi. Si disattivi, o si rimuova, la carta linee dal LM. 
 

 

Digitalizzazione di aree 

Per sperimentare la digitalizzazione di elementi areali, si entri nel VD con il nome aree per la nuova carta da costruire. 

 

 
 

Supponendo si vogliano delimitare degli appezzamenti di terreno con diversi tipi di coltura e con diverso reddito, si 

costruisca la table inserendo una colonna denominata Coltura con variabile di tipo varchar e dimensione 10, e una 

seconda colonna denominata Reddito con variabile double. Quindi Chiudi. 
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Come già specificato in precedenza, quando si digitalizza un poligono per definire un’area contenente una o più 

caratteristiche, gli attributi non vengono assegnati alla linea (bordo di area) che definisce il perimetro del poligono, ma ad 

un punto, definito centroide, ubicato all’interno del poligono. 

Nel VD sono disponibili tre modalità per la costruzione di un’area che prevedono l’utilizzo di tre diversi tasti che vengono 

visualizzati tramite la freccia alla destra del tasto  (il terzo della seconda fila). 

 

 
Il primo tasto consente di digitalizzare un bordo di area senza l’assegnazione di alcuna categoria, e inserire 

automaticamente il centroide, con assegnato un valore di categoria, al momento della chiusura del perimetro dell’area. La 

seconda opzione permette di digitalizzare soltanto il bordo, mentre la terza consente l’inserimento del centroide. 

Per sperimentare la prima delle tre opzioni è necessario inserire nel sottopannello Attributes il numero di categoria da 

attribuire al centroide che verrà inserito automaticamente alla chiusura del perimetro dell’area. Volendo assegnare al 

centroide la categoria 1, si apra il sottopannello Attributes , si attivi Manual entry e si inserisca 1 in Category number. 
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Si clicchi il tasto  (Digitize new area (boundary without category)). 
Utilizzando le stesse modalità utilizzate per la digitalizzazione di una linea, si tracci un poligono chiuso facendo coincidere 

l’ultimo nodo della spezzata con il primo. Alla pressione del tasto destro del mouse per terminare la digitalizzazione, l’area 

assume una colorazione verde a testimoniare l’avvenuta chiusura automatica del poligono e all’interno dell’area viene 

inserito il centroide (una crocetta blu).  

 

 
 

Se l’area non cambia colore e non compare il centroide, il poligono non è stato chiuso. La chiusura viene effettuata 

automaticamente solo se i due nodi si trovano ad una distanza reciproca inferiore al cosiddetto Snapping threshold (soglia 

di congiungimento automatico), che è impostato di default a 10 pixel e che può essere modificato a piacere dall’utente in 

qualunque momento mediante il pannello Digitizing settings.  Per il momento si ignori il poligono, o i poligoni, 

eventualmente non chiusi e se ne digitalizzi un altro. 

Se il poligono è chiuso correttamente, è possibile inserire gli attributi nell’apposito pannello. Si inserisca Mais in 

corrispondenza della variabile Coltura e 66.55 in corrispondenza di Reddito. Si prema quindi il tasto Submit. 
 

 
 

Un poligono che definisce un’area chiusa non è necessario sia costituto da un unico bordo, ma può essere costituito da più 

tratti digitalizzati separatamente e congiunti fra di loro a formare un poligono chiuso (è la modalità comune quando si 

digitalizzano poligoni di grande estensione). Come esempio si assuma di dover digitalizzare, utilizzando di nuovo la 

procedura appena sperimentata, un’area esagonale, digitalizzando separatamente due bordi costituiti ciascuno da tre lati 

dell’esagono. Si inserisca preventivamente in Attributes la categoria 2.  
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Si clicchi   (Digitize new area (boundary without category)) e si digitalizzi la prima linea, chiudendola con il tasto destro. 

 

 
 

Quindi si posizioni il cursore su uno dei due nodi alle estremità della linea e si digitalizzi la porzione restante del poligono. 

Alla chiusura dell’area poligonale viene inserito automaticamente il centroide.  

 

 
 

e visualizzato il pannello per l’inserimento degli attributi. Si inserisca nel pannello Frumento e 66.45, quindi Submit. 
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Per sperimentare il tracciamento di un bordo di area senza inserimento automatico del centroide, è innanzitutto necessario 

disattivare l’assegnazione di una categoria al bordo di area. Allo scopo, nel sottopannello Attributes si selezioni No 
category in Category mode (il valore presente in Category number è irrilevante) quindi il tasto Applica (per lasciare aperto 

il pannello). 

 

 
 
Si clicchi il tasto   (Digitize new boundary).  
 

 
 
e si digitalizzi quindi un nuovo poligono che, se chiuso correttamente, assume il colore verde.  
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Per inserire il centroide, con ad es. il valore di categoria 10, ed i relativi attributi, si selezioni innanzitutto la modalità 

Manual entry nel sottopannello Attributes (ancora aperto) e si digiti 10 in Category number. Si attivi quindi l’opzione Add 
new record into table e, come di consueto, Applica. 

 

 
 

Per inserire il centroide nel poligono si clicchi il tasto   Digitize new centroid.  

 

 
Si posizioni il cursore all’interno del poligono e si clicchi il tasto sinistro del mouse. Il centroide viene inserito. 
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e viene aperto il pannello per l’assegnazione degli attributi. Si inserisca Patate e 65.80 (quindi Submit). 
 

 
 

Con la stessa modalità si digitalizzi un altro poligono, costituito da tre bordi di area fra loro connessi e si inserisca 

successivamente il centroide con valore di categoria 25 e con gli attributi Avena e 45.78. 

 

In sintesi: 

a) In Digitization settings si selezioni No category e Applica. 
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b) Con   (Digitize new boundary) si digitalizzino i tre segmenti connessi fra di loro. 

 

 
 

c) In Attributes, si selezioni Manual entry,  si inserisca 25 in Category number, si attivi Add new record into table; quindi 

Applica. 

 

 
 

d) Si digitalizzi il centroide con   (Digitize new centroid). 
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e) Si inseriscano gli attributi. 

 

 
 

Si prema quindi il tasto    per uscire dalla funzione di digitalizzazione di un centroide. 

Si chiuda il sottopannello Attributes. 

Nel LM si apra la tavola degli attributi. 

 

 
 

Si chiuda la tavola degli attributi e si esca dal VD con il tasto . 
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Si visualizzi nel MD la carta aree attivando la visualizzazione delle categorie e dei centroidi. 

 

 
 

Si disattivi o si rimuova dal LM la carta aree. 

 

 

Altre funzioni del Vector Digitizer 

 

Per sperimentare le altre funzioni disponibili, si inserisca nel LM la carta provadig1 (una copia di provadig presente nel 

Mapset PERMANENT)che contiene un certo numero di elementi digitalizzati e per la quale è stata creata una table che, 

oltre al numero di categoria di ciascun elemento, contiene anche un attributo definito Nome di tipo varchar. Se a seguito 

dell’utilizzo delle funzioni descritte, e in particolare di quelle che comportano la modifica o la cancellazione degli elementi 

digitalizzati, la carta risultasse eccessivamente alterata, è possibile in ogni momento eseguirne una nuova copia (dopo aver 

cancellato la vecchia) utilizzando la carta provadig originale. Per conservare la carta originale inalterata è anche possibile, 

quando si esce dal VD, rispondere negativamente alla richiesta di salvataggio del file modificato. 

 

 
 

La carta contiene 5 punti singoli, 3 linee, 2 bordi di area aperti, 3 aree con i relativi centroidi, di cui una inserita all'interno 

di un'altra. Si faccia coincidere l’area di visualizzazione con la regione di default cliccando il tasto (Various zoom 
options) nel MD e selezionando l’opzione Zoom to default region.  

 

 
 

Si disattivi l’opzione Show comp. extent e si reimposti Coordinates nella cornice inferiore del MD. 
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Si visualizzi il contenuto della table. 

 

 
 

Dei 13 oggetti presenti nella carta solo 11 hanno un valore di categoria ed un attributo assegnati e sono quindi inseriti nella 

table (i due bordi di area aperti sono privi di categoria). Si chiuda la table.  

Si entri nel VD. 

 

 
 



 

 37 

Verranno ora sperimentate le funzioni degli altri tasti disponibili nel VD. 

 

Cancellazione di un punto, di una linea, di un bordo di area o di un centroide 

Il quarto tasto   (Delete selected point(s), line(s), boundary(ies) or centroid(s)) cancella l’elemento (o gli elementi) 

selezionati. Cliccato il tasto della funzione, si clicchi col tasto sinistro del mouse sul primo punto in alto a sinistra, che 

assume il colore giallo, quindi col tasto destro che ne determina la cancellazione. Con la stessa modalità si cancelli anche la 

prima linea in alto (tasto sinistro del mouse in un punto qualsiasi lungo la linea e tasto desto per conferma). 

 

 
 

Si possono cancellare più elementi contemporaneamente, selezionandoli tutti con il tasto sinistro e cliccando 

successivamente il tasto destro. Si visualizzi la table per verificare che la cancellazione comporta l’eliminazione degli 

elementi selezionati dal file della geometria, mentre la tavola degli attributi non subisce alcuna modifica.  

 

 
 

Si chiuda la table. Si esca dalla funzione con  (il quarto tasto della prima fila). 

  
Cancellazione di un’area 

Il quinto tasto   (Delete selected areas(s)) cancella le aree selezionate. Con il tasto sinistro all’interno dell’area viene 

effettuata la selezione, con il tasto destro l’area viene cancellata. Si sperimenti la funzione con l’area posta più in alto sulla 

destra. 
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Spostamento di un vertice o di un nodo  

Il sesto tasto    (Move selected vertex) permette di modificare la posizione di un nodo o di un vertice appartenenti ad 

una linea o a un bordo di area. Non può essere utilizzato per spostare i centroidi, per i quali deve essere utilizzata un’altra 

funzione (considerata in seguito). Per sperimentare la funzione si prema il tasto e si posizioni il cursore in corrispondenza 

del nodo sinistro della linea più alta. Si prema quindi il tasto sinistro del mouse (la linea viene evidenziata in giallo) e si 

sposti il cursore nella posizione in cui il vertice deve essere ricollocato. Si prema il tasto destro e il vertice viene spostato 

nella nuova posizione.  

Va considerato che nel caso dello spostamento di un nodo alla congiunzione di due linee, viene spostato solo uno dei due 

nodi e le due linee vengono separate. Analogamente, lo spostamento del nodo di un poligono chiuso comporta l'apertura del 

poligono. Si provi ad es. a spostare il nodo di chiusura della più grande delle 2 aree chiuse. Il poligono aperto cambia 

colore da verde (area chiusa) a grigio (bordo di area aperto) e il centroide da blu (centroide all’interno di un’area chiusa) ad 

amaranto (centroide esterno ad un’area). 

Si esca dalla funzione con .  

 

 
 

Inserimento di un vertice   

La funzione   (Add new vertex to line or boundary) permette di inserire un vertice lungo una linea o un bordo di area, che 

può successivamente essere spostato con la funzione vista in precedenza, e quindi consente di modificare l’andamento di 

una linea. Di deafult i vertici lungo le linee non sono evidenziati, per cui risulta utile, per verificare gli effetti 

dell’operazione, attivare la visualizzazione dei vertici. Allo scopo si clicchi  (Digitization settings) e nel pannello che 

viene aperto si clicchi su Simbology nella cornice superiore. Nel relativo sottopannello che viene aperto si attivi, mediante 

il tasto di spunta, l’opzione Vertex (la terz’ultima) Quindi i tasti Applica e Chiudi. 
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I vertici risultano ora visibili nel MD (crocette lilla) 

Si prema il tasto della funzione   e si posizioni il cursore lungo una linea in corrispondenza del punto in cui inserire il 

nuovo vertice (ad esempio a metà del primo segmento della linea più alta). Premendo il tasto sinistro del mouse la linea 

selezionata diventa gialla, col tasto destro il nuovo vertice viene inserito.  

 

 
 

 

Rimozione di un vertice 

La funzione  (Remove selected vertex) effettua la rimozione di un vertice (o di un nodo) modificando in tal modo 

l’andamento della linea. Premendo il tasto sinistro in corrispondenza di un vertice, la linea viene evidenziata in giallo. Col 

tasto destro il vertice viene cancellato. Si sperimenti la funzione con il primo vertice della linea più corta.  
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Si disattivi la visualizzazione dei vertici in Simbology. 

 

Editing di una linea   

La funzione   (Edit selected line/boundary) permette di aggiungere o togliere segmenti alle estremità di una linea. Per 

prolungare una linea mediante l’aggiunta di segmenti, si clicchi il tasto e si posizioni il cursore presso un’estremità della 

linea da modificare. Si clicchi il tasto sinistro del mouse per selezionare la linea, che assume il colore giallo, quindi si sposti 

il cursore per definire il nuovo segmento e si clicchi di nuovo il tasto sinistro per aggiungere il segmento. Ad ogni pressione 

del tasto sinistro del mouse viene aggiunto un nuovo segmento.  

 

 
 

Si clicchi il tasto destro per terminare l’operazione. Per cancellare segmenti aggiunti o preesistenti si posizioni il cursore 

sull’estremità della linea e si prema il tasto sinistro per selezionarla (la linea diventa gialla). Quindi si prema (e si tenga 

premuto) il tasto ctrl (control) della tastiera. Ad ogni clic sul tasto sinistro del mouse viene eliminato un segmento della 

linea. Con un clic sul tasto destro si termina l’operazione. 

 

Spostamento di un punto, di una linea, di un bordo di area o di un centroide   

La funzione   (Move selected point(s), line(s), boundary(ies) or centroid(s)) permette di spostare un punto singolo, un 

centroide, un’intera linea o un intero bordo di area (sono quindi esclusi i vertici e i nodi, per i quali esiste una specifica 

funzione già vista in precedenza). Le modalità sono le stesse per ciascuno di questi elementi. Attivata la funzione, per 

spostare uno dei punti singoli presenti nella carta si posizioni il cursore sul punto, si prema il tasto sinistro del mouse, si 

posizioni il cursore nel punto di spostamento e si clicchi il tasto destro. Nel caso di linee, il punto di spostamento può essere 

individuato in qualunque posizione lungo la spezzata e non necessariamente in corrispondenza di un nodo o di un vertice. 

Va considerato che quando un poligono, o più in generale una linea, è costituito da più linee congiunte fra di loro in 

corrispondenza di nodi, viene effettuato lo spostamento esclusivamente della linea selezionata e non dell’intero poligono 

(che da chiuso diventa aperto). Se un centroide viene spostato al di fuori di un’area, diventa un centroide esterno e cambia 

di colore; l’area corrispondente risulta ovviamente privata del numero di categoria. Si sposti ad esempio l’area con 

centroide portandola nella parte alta della carta e successivamente il centroide riportandolo all’interno dell’area. 

 



 

 41 

       
 

Si esca dal VD (con il tasto ) senza salvare le modifiche e si rientri con la stessa carta provadig1 (che risulta non 

modificata). 

 

Visualizzazione e modifica delle categorie   

L’undicesimo tasto (Display/update categories) permette di visualizzare, ed eventualmente cancellare, inserire e 

modificare, la categoria e/o il layer di appartenenza di un elemento (punto, linea, centroide) selezionato nel monitor tramite 

il tasto sinistro del mouse. 

Si è già visualizzata in precedenza la tavola degli attributi ed osservato che 11 dei 13 oggetti hanno un valore di categoria 

ed un attributo assegnati. 

Per sperimentare la cancellazione del numero di categoria (che non comporta la cancellazione dell’elemento digitalizzato 

dal file della geometria) e quindi dell’assegnazione dell’attributo associato alla categoria, si prema il tasto, si posizioni il 

cursore sul punto singolo in alto a sinistra e si clicchi il tasto sinistro del mouse. Il punto selezionato viene evidenziato in 

giallo e compare il seguente pannello. 

 

 
 

Da cui risulta che l’elemento (il punto singolo) è connesso al file della geometria tramite il Layer 1 ed ha assegnata la 

categoria 1. Per cancellare l’assegnazione della categoria si posizioni il cursore sul record e si clicchi il tasto destro del 

mouse. Il record assume uno sfondo blu e compare il pannello per la cancellazione del record. 

 

 
  

Si clicchi (indifferentemente col tasto destro o sinistro del mouse) l’opzione Delete selected che cancella la categoria dal 

pannello, quindi il tasto OK che rende effettiva la cancellazione e chiude il pannello (o il tasto Applica se si vuole effettuare 

la cancellazione e tenere aperto il pannello). 
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L’oggetto è stato privato della categoria, come verificabile cliccando di nuovo sull’elemento. 

Per sperimentare l’assegnazione di una categoria ad un oggetto che ne è privo, si può utilizzare lo stesso punto. Si clicchi 

sul punto e nel pannello visualizzato si introduca, ad es., 4 per il valore di categoria. Quindi un clic sul tasto Aggiungi e su 

OK. 

 

 

   
 

Al punto viene assegnata la categoria 4 (e automaticamente l’attributo punto 4 corrispondente alla categoria 4 nella tavola 

degli attributi).  

Le due procedure di cancellazione e inserimento della categoria, eseguite in sequenza su di uno stesso oggetto, equivalgono 

in pratica ad una modifica (o sostituzione) di categoria. Tale risultato tuttavia può essere conseguito più rapidamente in 

un’unica operazione. Ad es. si clicchi sulla linea più alta presente nella carta. La categoria assegnata alla linea è 6.  

 

 
 

Per modificare la categoria 6 in 26, si clicchi con il tasto sinistro in corrispondenza del numero 6, il cui sfondo assume il 

colore giallo.  
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Si digiti 26 in sostituzione del numero 6, quindi Aggiungi e OK. Viene effettuata la sostituzione. 

 

 
 

Se la carta fosse connessa a più layer (ma non è il caso attuale), la funzione consentirebbe la modifica delle categorie in 

ogni specifico layer, che andrebbe definito nella casella Layer:. 
E’ probabilmente superfluo evidenziare che le operazioni descritte modificano esclusivamente le categorie assegnate agli 

elementi digitalizzati, senza alcuna modifica del contenuto della table. 

 

Visualizzazione e modifica degli attributi  

Il tasto   (Display/update attributes) permette di visualizzare, ed eventualmente cancellare o modificare all’interno della 

table, gli attributi assegnati ai diversi oggetti digitalizzati. E’ pertanto una funzione che modifica permanentemente il 

contenuto della tavola degli attributi. 

Si clicchi il tasto e si posizioni il cursore sul punto singolo più a destra. Alla pressione del tasto sinistro del mouse compare 

la seguente finestra. 

 

 
 
Il punto singolo ha la categoria 4 e l’attributo punto 4 nella Colonna denominata Nome nella tavola degli attributi. Si digiti 

Pozzo 654 al posto di punto 4 e si clicchi Submit.  
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Si verifichi la modifica visualizzando la tavola degli attributi. 

 

 
 

Con la stessa funzione si verifichi che anche il primo punto in alto a sinistra, a cui si è in precedenza assegnata la categoria 

4, ha ora lo stesso attributo.  
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Strumenti addizionali 

Il tasto successivo  (Additional tools (copy, flip, connect, etc.)) apre un menu contenente numerose funzioni. 

 

 
 

Vengono di seguito illustrate le due funzioni di utilizzo più frequente. 

 Feature type conversion 

Cambia la tipologia degli elementi selezionati. I punti sono convertiti in centroidi, i centroidi in punti, le linee in 

bordi di area, e i bordi di area in linee. A titolo di esempio si clicchi l’opzione e si clicchi, prima con il tasto 

sinistro poi con il destro, sul primo punto in alto a sinistra che viene trasformato in un centroide, come evidenziato 

dal cambio di colore. Si clicchi (tasto sinistro, tasto destro) sulla prima linea in alto che viene trasformata in bordo 

di area (di colore grigio in quanto l’area è aperta). Si clicchi sul bordo dell’area chiusa più a destra, che viene 

trasformata in una linea: anche il centroide cambia colore non essendo più inserito all’interno di un’area. Si clicchi 

infine su un centroide, ad es. quello dell’area più piccola per trasformarlo in un punto. 

                
 

              Si clicchi sull’opzione per disattivarla. 
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Split line/boundary 
Divide una linea o un bordo di area in corrispondenza di una determinata posizione. Cliccata l’opzione si posizioni il 

cursore in un punto lungo la linea intermedia e si clicchi il tasto sinistro, poi quello destro. Viene inserito un nodo nel punto 

selezionato e la linea divisa in due parti distinte, ciascuna delle quali mantiene la categoria e gli attributi della linea 

originale. Si clicchi sull’opzione per disattivarla. 

 

Annullamento delle operazioni precedenti 

Il tasto  (Undo)  annulla le operazioni precedenti a ritroso. Ad ogni clic del tasto sinistro viene annullato il gruppo di 

operazioni eseguite con lo stesso comando. Se ad es. si cancellano in serie un certo numero di elementi e successivamente 

si digitalizza una nuova linea, con un clic sul tasto viene cancellata la linea, con un secondo clic vengono ripristinati tutti i 

punti. 

 

Ripristino delle operazioni precedenti 

Il tasto  (Redo)  ripristina le operazioni precedenti per tipologia di comando (come per il tasto precedente). 
 
Modifica del settaggio dell’ambiente di digitalizzazione 

Il tasto   (Digitization settings) consente di modificare il settaggio dell’ambiente di digitalizzazione mediante l’utilizzo 

di quattro sottopannelli, come già sperimentato in precedenza. 
         
Apertura del manuale del Vector Digitizer 

Il tasto  (Vector digitizer manual) apre la pagina del manuale del VD. 

 
Chiusura del Vector Digitizer 

Il tasto  (Quit digitizing tool) comporta l’uscita dall’ambiente di digitalizzazione, come sperimentato più volte in 

precedenza. Le modifiche effettuate durante la sessione di lavoro possono eventualmente essere annullate con un clic sul 

No del pannello di conferma che viene visualizzato. Un clic sul Si comporta invece la costruzione del file della topologia e 

l’uscita dall’ambiente di digitalizzazione con il salvataggio delle modifiche apportate. 

 

 
 
Si esca dal VD senza salvare le modifiche. 
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IIa PARTE – Esercizio di digitalizzazione  
 

Lo scopo di questo esercizio è la costruzione di un piccolo database contenente alcuni tematismi, in formato vettoriale e 

raster, rilevati da una carta topografica a curve di livello. L'acquisizione verrà effettuata digitalizzando direttamente da 

schermo mediante il mouse sull'immagine raster della carta topografica.  

Per ovvie ragioni viene considerata un'area di estensione molto limitata e vengono rilevati solo alcuni tematismi. Tuttavia 

le procedure utilizzate sono applicabili ad aree più ampie e per l'acquisizione di tematismi di tipo diverso. 

I tematismi che si intendono acquisire ed immettere nel database sono: 

1) Idrografia 

2) Modello Altimetrico Digitale (DEM) 

3) Edifici  

4) Rete stradale 

5) Vegetazione 

La porzione di carta topografica utilizzata nell'esercizio, alla scala 1:10000, è stata dapprima acquisita in formato TIFF 

tramite scanner, quindi importata in GRASS, rettificata e georeferenziata mediante le apposite funzioni disponibili in 

GRASS. La carta topografica è presente nel Mapset PERMANENT con il nome di topografia. 

 

Delimitazione dell'area di studio 

Nell'esercizio si assume un'area di studio delimitata dal quadrato di 500 m di lato definito dall'incrocio dei meridiani e 

paralleli rete presenti nella carta topografica. Pertanto la trasformazione delle mappe vettoriali in carte raster verrà 

effettuata in presenza di una maschera delimitante tale area. E’ pertanto necessario digitalizzare il perimetro dell'area di 

studio. 

Si entri in GRASS e si imposti la regione di default. Si inserisca nel LM, e si visualizzi nel MD, la carta raster topografia 

contenente gli elementi da digitalizzare e i meridiani e i paralleli rete da assumere come limiti dell'area di studio. 

 

 

                                        
 

Si entri VD tramite la procedura preferita inserendo come nome della carta da creare bordoarea e disattivando nel pannello 

l’opzione Create attribute table in quanto non è necessaria l’assegnazione di attributi ma solo del numero di categoria al 

centroide dell’area digitalizzata. Quindi OK. 

 

       
 

Nel sottopannello Attributes del Digitization settings (che viene aperto tramite  ) si selezioni Manual entry e si assegni 1 

come Category number in modo che al centroide venga assegnata tale categoria. Quindi Applica e Chiudi. 

Meridiani 

      rete 

Paralleli 

    rete 
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Per la digitalizzazione del quadrilatero che delimita l’area di studio si clicchi sul tasto  (Digitize new area (boundary 
without category) che, come già sperimentato in precedenza, consente la digitalizzazione di un bordo di area senza 

attribuzione di categoria e l’inserimento automatico del centroide (con il numero di categoria). Si posizioni quindi il cursore 

su uno dei 4 vertici del quadrato definito dai meridiani e paralleli rete, ad es. quello in alto a sinistra, e si prema il tasto 

sinistro del mouse per acquisire il primo punto (nodo iniziale). Si sposti quindi il cursore sul secondo vertice, ad es. quello 

in alto a destra, e si prema di nuovo il tasto sinistro per acquisire il secondo punto. Si continui con le stesse modalità 

connettendo il terzo e il quarto vertice. Per il tracciamento del quarto e ultimo lato, si posizioni il cursore in corrispondenza, 

o comunque il più vicino possibile, al punto di partenza (vertice in alto a sinistra) e si prema di nuovo il tasto sinistro per 

l’acquisizione dell’ultimo punto (nodo finale) e successivamente quello destro per terminare la digitalizzazione. Se i due 

nodi alle estremità del quadrilatero si trovano ad una distanza reciproca inferiore allo Snapping threshold (10 pixel di 

default) viene effettuata la chiusura automatica del quadrato, che assume il colore verde, e viene inserito il centroide. 
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Per verificare l’accuratezza della digitalizzazione del quadrilatero, risulta conveniente innanzitutto modificare la modalità 

di visualizzazione dell’area tramite il sottopannello Simbology del Digitization settings. Si disattivi la penultima opzione 

Area (closed boundary + centroid) in modo da eliminare la colorazione dell’area. Quindi Applica e Chiudi. 
 

 
 

Risulta ora visibile solo il bordo (verde) dell’area e risulta più facile verificare la corrispondenza con l’area definita dai 

meridiani e paralleli rete. Allo scopo si ingrandisca un vertice dell’area (ad es. quello in alto a destra) con i tasti (Zoom 

in) e   (Pan) e si proceda, se necessario, allo spostamento del vertice con il tasto  (Move selected vertex). 
 

 
 

Eseguito lo stesso controllo su tutti i vertici si esca dal VD con il tasto  (salvando la carta). 

Dal momento che il quadrato originale ha un lato di 500 m, e quindi un’area di 250.000 m2, è possibile effettuare una 

verifica della precisione della digitalizzazione calcolandone l’area mediante il comando v.report: 

 

Vector > Reports and statistics > Report topology by category [v.report] 

 

Nel pannello del comando si definisca bordoarea la carta vettoriale di input e nella casella sottostante si selezioni area 

come elemento da calcolare. 
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In Optional si selezioni meters come unità di misura per avere l’area in m2. 

 

 
 

Quindi Run per visualizzare l’area nel Command output. 
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Nel caso specifico l'area risultante, di 249594 m2, è di poco inferiore a quella reale e quindi la digitalizzazione può essere 

considerata sufficientemente accurata. 

Si chiuda il pannello e si disattivi la carta bordoarea nel LM. 

 

Digitalizzazione dell'idrografia 
Si assume che l'utilizzo futuro del database in costruzione non preveda alcuna analisi delle caratteristiche idrografiche, ma 

che la rete idrografica venga utilizzata per scopi esclusivamente illustrativi, vale a dire come tematismo descrittivo da 

sovrapporre in forma vettoriale ad altri tematismi. Questo uso limitato dell'idrografia ne rende particolarmente semplice 

l'acquisizione che consiste nella digitalizzazione indifferenziata della rete idrografica presente nell'area di studio senza 

l’assegnazione di un numero di categoria (ne’ tantomeno la costruzione di una tavola degli attributi).  

Con la carta topografia visualizzata, si entri nel VD con il nome idrografia per la carta da creare e disattivando l’opzione 

Create attribute table. 

 

      
 

I corsi d’acqua sono rappresentati in nero nella carta topografica. Dal momento che le linee digitalizzate vengono 

rappresentate di default nello stesso colore, risultano difficilmente visibili. E’ pertanto opportuno definire un colore diverso 

per le linee, ad es. il rosso, mediante il sottopannello Symbology già utilizzato in precedenza.  

Si clicchi sulla casella del colore relativa a Line e nella tavolozza che appare si clicchi sul colore rosso. Quindi il tasto 

Applica. Per rendere le linee più visibili si apra il sottopannello General e si porti a 3 (pixel) la larghezza delle linee, quindi 

il tasto Applica.  

 

      
 

Dal momento che non è richiesta l’attribuzione dei valori di categoria, nel sottopannello Attributes si selezioni No category 

in Category mode. Quindi Applica e Chiudi.  
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Nell'area sono presenti due corsi d'acqua, uno ubicato nella porzione nord-est dell'area, mentre il secondo attraversa la 

porzione meridionale dell'area da ovest verso est. In ciascuno di essi confluiscono due affluenti più piccoli.  

Per digitalizzare il corso d’acqua ubicato nella parte inferiore dell'area, si prema il tasto il tasto   (Digitize new line)  e si 

posizioni il cursore lungo il corso d'acqua in corrispondenza dell'intersezione con il meridiano rete che delimita l'area sulla 

sinistra. Si prema il tasto sinistro per digitalizzare il punto di intersezione, quindi si muova il cursore lungo il corso d'acqua 

premendo ripetutamente il tasto sinistro fino al contatto con il piccolo affluente proveniente da sud. Per quanto nel caso in 

esame non risulti strettamente necessario (per l'utilizzo esclusivamente descrittivo della carta vettoriale), è buona norma 

interrompere la digitalizzazione di una linea in corrispondenza dell'intersezione con altre linee in modo da avere la perfetta 

connessione fra le linee tramite l'unione dei nodi presenti alle estremità.  

Si prema quindi il tasto destro per terminare la digitalizzazione di questo primo tratto fluviale.  

 

 
 

Utilizzando la stessa procedura, si digitalizzi quindi il secondo tratto del corso d'acqua, partendo dall'ultimo punto 

digitalizzato (punto di confluenza), fino all'intersezione con il meridiano rete che delimita l'area sulla destra.  
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Si posizioni quindi il cursore di nuovo nel punto di confluenza e si digitalizzi in modo analogo il segmento fluviale 

affluente, fino all'intersezione con il parallelo che delimita inferiormente l'area. 

 

 
 

Si noti (eventualmente ingrandendo l’immagine) che all'intersezione fra le tre linee è presente una crocetta verde che sta ad 

indicare la perfetta connessione fra i tre segmenti. 

Utilizzando gli stessi criteri, si digitalizzino quindi i tre segmenti fluviali che compongono la rete idrografica nella parte 

superiore dell'area. 

 

 
 

Alla fine delle operazioni la carta contiene 6 linee, prive dei valori di categoria, suddivise in due gruppi di tre linee 

ciascuno. 

Si esca dal VD e nel LM si disattivi topografia e si visualizzi bordoarea (che viene visualizzata con i bordi in nero e il 

riempimento in grigio di default) e idrografia (selezionando il colore blu). 

 

Si dovrebbe ottenere la seguente immagine. 
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Costruzione del modello altimetrico digitale (DEM) 

Le operazioni da eseguire sono: 

a ) Digitalizzazione delle caratteristiche altimetriche rappresentate dalle curve di livello (o isoipse) e dai punti quotati.  

b) Trasformazione della carta vettoriale in una carta raster e costruzione del DEM, in presenza della maschera rappresentata 

dal vettoriale bordoarea, tramite l'apposito comando di GRASS. 

 

a) Digitalizzazione  delle caratteristiche altimetriche 

Si visualizzi nel MD la carta topografia e si disattivino le altre carte eventualmente presenti.  

Nella carta topografica di base l’equidistanza (differenza di quota fra le isoipse adiacenti) è di 5 m e le isoipse direttrici 

(disegnate con tratto più spesso) hanno valori multipli di 25 m. Si noti che l’isoipsa direttrice che attraversa da est a ovest la 

parte medio-alta dell’area in esame ha una quota di 400 m, come indicato sull’isoipsa stessa. Dal momento che procedendo 

verso nord-ovest le quote aumentano, la direttrice successiva, ubicata in prossimità del vertice nord-ovest, ha una quota di 

425 m, mentre la direttrice inferiore, ubicata in prossimità del corso d’acqua, ha una quota di 375 m. La quota di tutte le 

altre isoipse è facilmente deducibile considerando che l’equidistanza è di 5 m.  

Va considerato che la costruzione del DEM, che è una carta raster, viene effettuata mediante interpolazione dei valori 

altimetrici nell'immediato intorno di ciascuna cella. Per permettere il calcolo dei valori altimetrici anche nelle celle lungo i 

margini dell’area, è quindi necessario digitalizzare le isoipse anche leggermente al di fuori dell’area in esame. 

A differenza a quanto fatto per la rete idrografica, in questo caso è necessario attribuire un valore numerico agli elementi 

digitalizzati, costituito dalla quota delle isoipse e dei punti quotati. Dal momento che è l'unica caratteristica che si intende 

attribuire agli elementi digitalizzati (d'altra parte è difficile immaginare per un’isoipsa altri attributi di un qualche interesse 

pratico) si può attribuire la quota come numero di categoria evitando la costruzione di una apposita tavola degli attributi. 

Va tuttavia considerato che un numero di categoria deve essere un numero intero, per cui questa scelta impedisce 

l’introduzione di valori altimetrici decimali. La limitazione non riguarda le isoipse, caratterizzate comunque da un valore 

intero, ma eventualmente i punti quotati, che hanno una quota espressa con valori decimali. Questi ultimi possono tuttavia 

essere arrotondati senza compromettere l’attendibilità della carta. Nel caso in cui si volessero utilizzare valori decimali per 

le quote, si renderebbe indispensabile la costruzione di una tavola degli attributi. 

Si entri nel VD denominando altimetria la carta vettoriale e disattivando la creazione della tavola degli attributi. 

 

           
 

Come i corsi d’acqua, anche le isoipse e i punti quotati sono rappresentati in nero nella carta topografica. Anche in questo 

caso è quindi utile definire il colore rosso per le linee (Line) e per i punti (Point) nel sottopannello Symbology, seguendo la 

procedura già adottata in precedenza.  
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Dal momento che si è deciso di attribuire alle isoipse e ai punti quotati come categoria il valore altimetrico, nel 

sottopannello Attributes si selezioni Manual entry in Category mode e si lasci aperto il pannello. 

 

 
 

Si ingrandisca la porzione nord-ovest dell’area. 

La prima isoipsa da digitalizzare è quella esterna all’area ed ubicata in prossimità del vertice nord-ovest, la cui quota è 440 

m. Si inserisca quindi il valore 440 in Category number nel sottopannello Attributes (ancora aperto). Quindi Applica. 
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Si esegua la digitalizzazione dell'isoipsa con il tasto   (Digitize new line).  
 

 

 
 

Terminata la digitalizzazione, si verifichi che all’isoipsa è stata assegnata la categoria 440 con il tasto  (Display/update 
categories).  
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Si proceda allo stesso modo per l’isoipsa successiva la cui quota è di 435 m, inserendo 435 in Category number. 
 

 
 

E digitalizzando l’isoipsa con   (Digitize new line). 
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Si utilizzi la stessa procedura per tutte le altre isoipse. Per accelerare le operazioni è possibile omettere qualche isoipsa o 

digitalizzarle alternativamente: ovviamente il DEM finale risulterà in tal caso meno accurato. 

Non è necessario digitalizzare un’intera isoipsa mediante un’unica linea. E’ possibile digitalizzarla in più linee distinte, ma 

connesse in corrispondenza dei nodi.  

Operativamente risulta conveniente, definita una quota e cliccata la funzione   (Digitize new line), mantenersi sulla 

stessa isoipsa spostando l’immagine con un clic sulla rotellina del mouse. Va ricordato che durante la digitalizzazione è 

possibile cancellare dei punti a ritroso con la combinazione tasto ctrl + tasto sinistro e che è possibile modificare la 

categoria di una linea con (Display/update categories). 
 

Un’altra informazione altimetrica è rappresentata dai 5 punti quotati riportati nella carta. Va considerato che i punti quotati 

risultano particolarmente utili per una costruzione accurata di un DEM quando ubicati sulla sommità di rilievi o sul fondo 

di depressioni. Per quanto nella carta in esame nessuno dei punti quotati presenti queste caratteristiche, può essere utile 

digitalizzarne uno, ad es. quello ubicato all'incrocio delle due strade nella porzione nord occidentale della carta, per 

sperimentare l’inserimento di un dato puntuale. Si ingrandisca la porzione di immagine nell’intorno dell’incrocio, si 

inserisca come categoria 404 (arrotondando la quota 403.6 riportata sulla carta) in Attributes e si digitalizzi il punto con la 

funzione  (Digitize new point). Appare una crocetta rossa (è il colore precedentemente selezionato in Symbology) in 

corrispondenza del punto. 
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Al termine della digitalizzazione di tutte le isoipse la carta dovrebbe avere un aspetto simile al seguente. 

  

 
 

La carta creata risulta sicuramente più leggibile, e gli eventuali errori e/o omissioni più evidenti, eliminando dallo sfondo la 

carta topografica di base e visualizzando i valori di categoria assegnati alle isoipse. Allo scopo si disattivi la carta 

topografia nel LM, si clicchi col tasto destro su altimetria e con Properties si apra il pannello del comando d.vect. Si 

attivi Display category numbers of features. Quindi Applica e Chiudi. 
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Vengono visualizzate le isoipse e il punto quotato digitalizzati e i rispettivi valori di quota. Le crocette verde scuro 

rappresentano i punti di connessione fra i diversi tratti delle isoipse digitalizzati separatamente. 

 

 
 

Si apportino le eventuali correzioni e si esca dal VD. 

 

b) Trasformazione della carta vettoriale in una carta raster e costruzione del DEM 

Per la costruzione di un DEM è innanzitutto necessaria una trasformazione della carta vettoriale in formato raster, mediante 

il comando v.to.rast: 

 

File > Map type conversions > Vector to raster [v.to.rast] 

 

Si inserisca il nome altimetria sia come input che come output e si selezioni cat nella casella Source of raster values: per 

attribuire alle celle che nella carta raster costituiscono le linee il valore di categoria (quota). Quindi Run e Chiudi. 
 



 

 61 

 
 

Si visualizzi la carta raster risultante che riproduce in formato raster, con celle di 1 m di lato, le curve di livello e il punto 

quotato con diversi colori a seconda del valore altimetrico. Se nel LM è selezionata la carta vettoriale altimetria, vengono 

visualizzati anche i valori altimetrici. 

 

 
 

Per la costruzione del DEM da una carta raster a curve di livello, è previsto in GRASS un apposito comando, 

r.surf.contour. Prima di procedere, risulta però necessaria l'introduzione di una maschera che limiti la costruzione del 

DEM alla sola area di studio, mediante il comando r.mask. Una carta vettoriale che delimita l'area è stata appositamente 

creata in precedenza con il nome di bordoarea. Per l’attivazione del comando: 

 

Raster > MASK 

 

Nel pannello è sufficiente selezionare il sottopannello Vector, inserire il nome della carta bordoarea e cliccare Run.  
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Da questo momento la maschera è attiva ed ogni elaborato visualizzato, e il DEM che verrà prodotto, avrà un’estensione 

corrispondente a quella della maschera (non si chiuda il pannello che verrà riutilizzato per disattivare la maschera). 

 

Per la costruzione del DEM: 

 

Raster > Interpolate surfaces > Raster contours [r.surf.contour] 

                

con altimetria come raster di input e areadem come carta risultante. Quindi Run. 

 

 
 

Nel MD, disattivando le eventuali altre carte presenti, la carta areadem ha il seguente aspetto. 
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Con l’opzione Metadata, che esegue il comando r.info, 

 

 
 

si ottiene: 
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Da cui risulta che i valori calcolati variano da un minimo di 350 ad un massimo di 435 m. 

 

Si tolga la maschera attivando semplicemente Remove existing MASK nel sottopannello Remove del comando r.mask 

aperto in precedenza e cliccando ovviamente Run. 

 

 
 

 

Digitalizzazione degli edifici, della vegetazione e della rete stradale 

La carta topografica, oltre alla rete idrografica e all’altimetria, contiene altre informazioni relative alle caratteristiche del 

territorio. Sono infatti cartografati due edifici con la circostante area cortilizia, le strade (suddivise in due tipologie: le 

strade comunali, rappresentate da una doppia linea a tratto continuo, e le strade campestri a doppia linea tratteggiata), le 

aree coperte da bosco (delimitate a tratteggio e contenenti dei cerchietti) e quelle incolte o a prato-pascolo (tutte le aree non 

coperte da bosco). Per considerare una terza tipologia di vegetazione, si può assumere che l’area cortilizia di pertinenenza 

dei due edifici sia interamente coperta da prato. Dalla carta è quindi possibile estrarre i seguenti tematismi: 

1) Edifici e aree di pertinenza 

2) Vegetazione 

3) Rete stradale 
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E' ovviamente possibile digitalizzare separatamente i singoli tematismi, creando per ciascuno di essi uno specifico file della 

geometria ed una specifica tavola degli attributi. In tal caso tuttavia molti degli elementi presenti nella carta dovrebbero 

essere digitalizzati più volte (e con risultati diversi). Infatti, se si osserva la carta topografica, è evidente che molte linee 

delimitano contemporaneamente oggetti appartenenti a diversi tematismi; ad es. un limite di strada è anche un limite di 

un'area incolta o di un bosco. Per ottimizzare le operazioni è quindi conveniente digitalizzare contemporaneamente tutti gli 

oggetti inserendoli in un unico file contenente la geometria, ma collocando i diversi tematismi su layer diversi, ciascuno dei 

quali connesso ad una specifica tavola (table) degli attributi, come descritto in una sezione precedente.  

 

Nell’acquisizione dei dati verrà assunta la seguente struttura per le table relative ai tre tematismi da acquisire: 

  

table edifici (connessa al layer 1)  

 
 

table vegetaz (connessa al layer2) 

 

 table strade (connessa al layer3)     

 

 

cat 

Denomin. Colonna 

Tipoedi 

  

cat 

Denomin. Colonna  

Tipoveg 

  

cat 

Denomin. Colonna 

Tipostr 

1 Edificio ad uso civile  1 Bosco  1 Strada comunale 

2 Edificio ad uso rurale  2 Incolto o prato-pascolo  2 Strada campestre 

3 Area di pertinenza  3 Prato    

 

Per poter creare le tre table e connetterle ad una carta, è necessario che quest’ultima esista. E' quindi necessario crearla, 

anche se priva di contenuti, prima di iniziare la digitalizzazione. Per la creazione della carta, che verrà denominato topo3, 

si utilizza l’apposito pannello che viene aperto tramite: 

 

Vector > Develop vector map > Create new vector map 

 

Nel pannello si inserisca il nome della carta topo3 e si disattivi l’opzione Create attribute table per evitare che venga 

costruita automaticamente una tavola degli attributi con lo stesso nome della carta (infatti si vogliono costruire tre tavole 

degli attributi con nomi assegnati dall’utente e diversi dal nome della carta).  Quindi OK. 

 

         
 

La carta viene creata e inserita nel LM (nel MD non appare ovviamente alcuna immagine essendo la carta priva di 

contenuti). 

Per creare e connettere le tre table alla carta si apra la tavola degli attributi. 
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Viene visualizzato il messaggio che non esiste nessuna connessione della carta al database (infatti non si è  creata nessuna 

table connessa a nessun layer). Si clicchi OK. 

 

 
 

Nella finestra che viene aperta si clicchi su Manage layers. 
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In Table name:, nella sezione sulla destra del pannello, si inserisca il nome, edifici, della prima table da creare. Quindi si 

clicchi il tasto Create table. Il nome della tavola viene inserito in Table: nella sezione sulla sinistra. Cliccando il tasto Add 
layer la connessione della table alla carta tramite il layer 1 viene effettuata come riportato nella List of layers nella parte 

superiore del pannello. 

 

         
 

Nella table, attualmente priva di contenuti, deve essere inserita la colonna Tipoedi. Allo scopo si clicchi su Manage tables, 

nella cornice inferiore del pannello, e si inserisca in Column il nome, Tipoedi, della colonna da inserire, varchar come 

tipologia di contenuto e 30 come numero massimo di caratteri.  

 

 
 

Con un clic sul tasto Add la colonna viene inserita. 
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Per inserire i numeri di categoria e i relativi attributi nella colonna Tipoedi, si clicchi Browse data nella cornice inferiore, e 

nel pannello che viene aperto si clicchi col tasto destro in un punto qualsiasi della finestra. Nel menu che viene aperto si 

clicchi sull’opzione Insert new record. 
 

 
 

Nel pannello che viene aperto, in cui è già definito il numero di Categoria 1, si digiti l’attributo, Edificio ad uso civile, da 

assegnare alla Categoria, quindi il tasto Submit. L’attributo viene inserito nella table. 
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Si proceda allo stesso modo per inserire l’attributo Edificio ad uso rurale in corrispondenza della Categoria 2 

 

 

    
 

E per inserire il terzo attributo, Area di pertinenza. 

 



 

70 

 

    
 

A questo punto la table edifici è completa. 

 

Per creare e connettere la seconda table, da denominare vegetaz, si procede nello stesso modo, utilizzando il pannello 

ancora aperto (o aprendolo di nuovo con Show attribute data). In sintesi: 

a) Clic su Manage layers (il numero del Layer è automaticamente incrementato a 2). 

b) Inserimento del nome della table (vegetaz), tasto Create table, tasto Add layer. 
 

 
 

 

c) Clic su Manage tables, inserimento del nome della Colonna (Tipoveg), della tipologia (varchar) e della lunghezza 

(30), quindi Add. 
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d) Clic su Browse data e clic su Insert new record. 
 

 
 

e) Inserimento dei tre attributi 
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La table è completa. 

 

 
 

e si può procedere alla costruzione e connessione della terza table (strade) con un clic su Manage layer. 
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All’inserimento della colonna Tipostr. 
 

 
 

E all’inserimento dei due attributi. 

 



 

74 
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Le tre table sono complete e si può uscire dal pannello con Chiudi. 
 

Per iniziare la digitalizzazione dei tre tematismi si inserisca la carta raster topografia al di sotto della carta vettoriale topo3 

e si entri nel VD con la carta topo3 come carta da digitalizzare. 

 

   
 

Prima di iniziare la digitalizzazione è opportuno modificare in Symbology i colori di default dei vari elementi digitalizzati, 

in modo da renderli più facilmente visibili sulla base topografica. La scelta dei colori è ovviamente molto soggettiva. Per la 

digitalizzazione illustrata nelle pagine seguenti è stato utilizzato il seguente settaggio. 

 

 
 

Tutti gli elementi da digitalizzare sono degli elementi areali ed è quindi necessario digitalizzare il perimetro che li delimita 

(privo di categoria) ed inserire all’interno del perimetro un centroide a cui vanno assegnati gli attributi che caratterizzano 

l’elemento areale e che sono contenuti nelle tre table precedentemente costruite. L’assegnazione dell’attributo viene 

effettuato definendo il numero del layer a cui è connessa la table e il numero di categoria presente nella table.   

Ad es. il più grande dei due edifici riprodotti nella porzione nord-ovest della carta è un Edificio ad uso civile. Per 

assegnargli tale attributo è quindi necessario assegnargli la categoria 1 della table edifici, connessa al file della geometria 

tramite il Layer 1. Per digitalizzare l’edificio si può utilizzare il tasto  che, come sperimentato in precedenza, prevede la 
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digitalizzazione del perimetro dell’elemento e l’inserimento automatico del centroide con il numero di categoria e il 

numero del layer, che vanno pertanto definiti a priori. Allo scopo si apra il pannello Attribute tramite il tasto  e si 

inserisca 1 come numero del Layer e 1 come numero di categoria. Quindi Applica e Chiudi. 
 

 
 

Si ingrandisca la porzione nord-ovest della carta, si clicchi il tasto   e si digitalizzi il perimetro dell’edificio. Alla 

chiusura del perimetro viene inserito automaticamente il centroide. 

 

 
  

A questo punto l’edificio è salvato nel file della geometria e connesso, tramite il layer 1, alla categoria 1 della table edifici, 
in cui è stata inserita, nella colonna Tipoedi, la denominazione Edificio ad uso civile, come si può facilmente verificare con 

il tasto di interrogazione degli attributi . 
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Per digitalizzare il secondo edificio, da definirsi Edificio ad uso rurale, si apra il pannello Attributes e si inserisca 1 come 

numero del Layer e 2 come numero di categoria. Quindi Chiudi e Applica. 

 

 
 

Si ingrandisca la porzione della carta contenente il secondo edificio. Si noti che il perimetro dell’area cortilizia, 

rappresentato a tratteggio, si interseca con il perimetro dell’edificio in due punti.  
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Quando due bordi di area si intersecano, è necessario che nei punti di intersezione siano presenti dei nodi. Il perimetro 

dell’edificio va quindi digitalizzato in due porzioni separate dai punti di intersezione con il perimetro dell’area cortilizia. Si 

clicchi pertanto il tasto  e si digitalizzi la prima porzione del perimetro dell’edificio compresa fra le due intersezioni (è 

indifferente quale delle due porzioni viene digitalizzata per prima, così come è ininfluente il senso di digitalizzazione).  

 

 
      

Quindi si digitalizzi la seconda porzione partendo da uno dei due nodi della porzione di bordo precedente. Al 

completamento del perimetro l’area viene chiusa e il centroide inserito automaticamente. 

 

 
 

Si verifichi con il tasto di interrogazione degli attributi  l’assegnazione della denominazione Edificio ad uso rurale. 

 

 
 

Per completare la digitalizzazione dell’area cortilizia di pertinenza dei due edifici, si può utilizzare lo stesso tasto  

utilizzato per la digitalizzazione dei due edifici, oppure digitalizzare dapprima il perimetro dell’area senza assegnare alcun 

attributo, mediante il tasto  , e successivamente inserire al suo interno il centroide, mediante il tasto   , con gli 
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attributi da assegnare all’area. Per utilizzare questa seconda procedura, si selezioni innanzitutto No category nel 

sottopannello Attributes, quindi Applica e Chiudi. 
 

 
 

Come per uno degli edifici precedenti, anche in questo caso il perimetro dell’area cortilizia va digitalizzato in tratti separati 

in corrispondenza delle intersezioni con la strada comunale sulla destra e con la strada campestre a sud (come dalla figura 

seguente).  

 

 
 

Per l’assegnazione degli attributi mediante l’inserimento del centroide, si apra il sottopannello Attributes e si inserisca 1 

come numero del Layer e 3 come numero di categoria. 
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Quindi si digitalizzi il centroide all’interno dell’area. 

 

 
 

In precedenza si è assunto che l’area cortilizia sia ricoperta interamente da prato ed è pertanto necessario attribuirle anche 

la categoria 3 del Layer 2. Allo scopo si clicchi il tasto e successivamente il centroide dell’area cortilizia. 

Viene aperto il pannello con l’assegnazione del Layer 1 e della categoria 3. Nella sezione inferiore, Add new category, si 

inseriscano il Layer 2 e la categoria 3, quindi Aggiungi.  
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La nuova assegnazione viene effettuata. 

 

 
 

Si clicchi OK. 

A questo punto il centroide, e quindi l’area a cui si riferisce, ha una doppia collocazione: tramite il layer 1 nella table 

edifici con il numero di categoria 3 e la denominazione Area di pertinenza; tramite il layer 2 nella table vegetaz con il 

numero di categoria 3 e la denominazione Prato  La doppia assegnazione può essere verificata con il tasto di 

interrogazione . 

 

 
 

Osservando la carta topografica si può constatare che molti degli elementi da digitalizzare (ad es. le strade) si estendono 

oltre i limiti dell’area di studio definita dai paralleli e meridiani rete. Il perimetro di ciascun elemento da digitalizzare deve 

quindi essere interrotto in corrispondenza del bordo, e il segmento di chiusura digitalizzato in coincidenza con un tratto del 

bordo stesso. Va tuttavia considerato che si dispone già di un perimetro digitalizzato dell’intera area, il vettoriale 

bordoarea utilizzato per la costruzione della maschera, per cui risulta più elegante e più preciso utilizzarlo per la chiusura 

delle aree.   

Per inserire il perimetro dell'area precedentemente digitalizzato nella carta corrente topo3 si utilizza il comando v.patch 

con l’opzione append. Si esca pertanto dal VD e dal LM si selezioni: 
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Vector > Overlay vector maps > Patch vector maps [v.patch] 

 

Nel pannello del comando si inserisca bordoarea in Name of input vector map(s): e topo3 come Name for output vector 
map:. 
 

 
 

Nel sottopannello Optional si attivi l’opzione Append files to existing file e l’opzione Allow output files to overwrite 
existing files. Quindi Run. 

 

          
 

Si entri nel VD con topo3, che contiene ora anche il perimetro dell’area (con il relativo centroide). 
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Si elimini il centroide dell’area, non più necessario, con il tasto . Rimane esclusivamente il bordo dell’area (privo di 

attributi). 

 

 
 

Si può ora procedere alla digitalizzazione degli altri elementi (tutti areali) presenti nella carta. Si digitalizzi ad es. la strada 

campestre che dall’area cortilizia precedentemente digitalizzata si estende fino al bordo sinistro dell’area. Per permetterne 

la chiusura in corrispondenza del lato della squadratura, è indispensabile vengano creati dei nodi lungo la squadratura in 

corrispondenza dell'intersezione dei bordi con le linee che delimitano la strada.  
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Per inserire i nodi si clicchi il tasto  e nel menu che viene aperto si attivi la funzione Split line/boundary (che rimane 

attiva fino a quando non esplicitamente disattivata). 

 

 
 

Quindi si posizioni il cursore in corrispondenza del punto di inserimento del nodo e si clicchino nell’ordine il tasto sinistro 

e quello destro del mouse. Si ripeta l’operazione per il secondo punto. Le crocette testimoniano l’avvenuto inserimento dei 

nodi. 

 



 

 85 

 
 

Supponendo di utilizzare il tasto  (digitalizzazione del bordo di area e inserimento automatico del centroide) si selezioni 

in Attributes l’opzione Manual entry e si inserisca 3 per il Layer e 2 per la categoria.  

 

 
 

Partendo dai due nodi appena inseriti, si digitalizzino ora i due bordi della strada campestre fino a congiungerli con i bordi 

dell'area cortilizia digitalizzati in precedenza. Alla chiusura dell’area viene automaticamente inserito il centroide. Il colore 

arancio dei bordi di area sta semplicemente ad indicare che tali bordi delimitano contemporaneamente due aree. 
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Poiché la colorazione di riempimento delle aree impedisce la visualizzazione degli elementi da digitalizzare, si clicchi e 

nel sottopannello Simbology si disattivi la visualizzazione delle aree. 

 

 
 

 



 

 87 

 
 

Si digitalizzi anche la strada campestre al centro dell’area di studio utilizzando ancora una volta il tasto  . Il pannello 

Attribute non richiede modifiche in quanto già impostato con Layer 3 e Category 2. Il segmento comune con la strada 

comunale deve essere digitalizzato come un segmento distinto, in quanto costituisce anche una porzione del bordo della 

strada comunale.  

 

 
 

Si digitalizzino ora le strade comunali (che formano un’unica area) dopo aver inserito i nodi necessari lungo il perimetro. 

Durante la digitalizzazione è buona norma, come si è già detto, interrompere la digitalizzazione, con il conseguente 

inserimento di nodi, in corrispondenza dell’intersezione con i bordi di altri elementi da digitalizzare. La strada comunale 

sulla destra dell’area interseca ad esempio dei limiti di bosco e una strada campestre, oltre al limite della squadratura. Si 

tenga tuttavia presente che i nodi necessari possono anche essere inseriti successivamente senza compromettere le 

caratteristiche dell’area interessata.  
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Dal momento che l’area da digitalizzare è piuttosto estesa, risulta conveniente digitalizzare dapprima i bordi privi di 

categoria (con il tasto  )  ed inserire successivamente il centroide con gli attributi (con il tasto  ). Quindi nel 

sottopannello Attributes si selezioni No category per digitalizzare i bordi. 

 

 
 

Una volta completato il tracciamento dei bordi si definisca nello stesso sottopannello il Layer 3 e la Category 1 e si 

digitalizzi il centroide in un punto qualsiasi all’interno della strada.  
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 A questo punto la carta dovrebbe avere il seguente aspetto. 

 

 
 

Si digitalizzi ora l’area a bosco circostante il corso d’acqua nella parte superiore della carta, dopo aver inserito i due nodi 

necessari lungo il bordo e, se non inseriti precedentemente, lungo la strada comunale. E dopo aver selezionato No category 

in Attributes. 

 



 

90 

 

   
 

Digitalizzati i bordi, si selezioni Manual entry, si definiscano il Layer 2 (table vegetaz) e la categoria 1 (Bosco) in 

Attributes e si inserisca il centroide (con il tasto  ). 

 

    
 

Le linee finora digitalizzate hanno automaticamente delimitato (e chiuso) le tre aree a Incolto o prato-pascolo ubicate 

nella porzione nord ovest dell’area, a cui può quindi essere assegnato un centroide. 
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 In Attributes si selezioni Manual entry, si inserisca Layer 2 (table vegetaz) e Category 2 (Incolto o prato-pascolo). 

Quindi Applica. Quindi si digitalizzino di seguito i tre centroidi.  

 

       
. 

Si proceda quindi alla digitalizzazione di tutti gli altri elementi della carta assegnando le rispettive categorie e layer di 

appartenenza. 

Da un punto di vista operativo risulta conveniente digitalizzare tutti i bordi delle aree e solo successivamente assegnare il 

centroide con le categorie.  

L’unica zona che potrebbe presentare qualche dubbio di interpretazione si trova nella porzione nord est della carta, dove 

una strada campestre entra in un’area a bosco dividendola in due parti, che vanno pertanto digitalizzate come due elementi 

distinti inserendo i nodi nelle opportune posizioni. 

 

2 

1 

3 
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L’inserimento di un centroide in un’area molto piccola (ce ne sono alcune nella porzione nord-est della carta) può 

provocare un congiungimento automatico del centroide digitalizzato ad un nodo vicino. Per evitare l’inconveniente, è 

opportuno ingrandire sensibilmente l’area in esame prima dell’inserimento.  

Il risultato finale della digitalizzazione dovrebbe essere simile al seguente (attivando la visualizzazione delle aree nel  

sottopannello Simbology). Le eventuali aree prive del riempimento (verde) indicano la mancanza del centroide. Le crocette 

rosse indicano i nodi, quelle blu i centroidi. I bordi di area che delimitano più aree contemporaneamente sono riportate in 

arancio, quelli che delimitano una singola area in verde (solo l’edifico più grande a nord ovest dell’area). 

 

 
 

Dopo aver effettuate le eventuali correzioni si esca dal VD. 

 

Per quanto digitalizzati in un unico file, i tre tematismi possono esser analizzati singolarmente. Ad esempio, per 

visualizzare nel MD la sola vegetazione (layer 2) con i centroidi e i numeri di categoria, si carichi (se non già presente) la 

carta topo3 nel LM e si apra il pannello del comando d.vect. 

 



 

 93 

 
 

In Required si attivi Display category numbers of features. In Selection si inserisca 2 come Layer number or name e si 

attivi l’opzione centroid. In Label si selezioni 2 in Layer number for labels. Quindi OK. 

 
L’immagine risultante dovrebbe essere simile alla seguente. 
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La stessa procedura può essere utilizzata ovviamente per visualizzare ciascuno degli altri due tematismi. 

 

E’ anche possibile creare delle carte raster contenenti un singolo tematismo. Per ottenere ad esempio una carta contenente 

la rete stradale, si acceda a v.to.rast mediante: 

 

File >  Map type conversions > Vector to raster [v.to.rast] 

 

Nel pannello si inserisca topo3 come carte vettoriale di input, topo3.strade come carta raster risultante, cat per i valori da 

assegnare alle celle della carta raster e nel sottopannello Optional si selezioni 3 come numero del layer da considerare.  

 

   
 

Quindi Run (e Chiudi).  

Visualizzando nel MD (dopo aver disattivato la visualizzazione precedente) la nuova carta topo3.strade, si ottiene la 

seguente immagine, in cui le due categorie di strade sono distinte da una diversa colorazione. 
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Per costruire una carta vettoriale contenente uno singolo tematismo, estraendola dalla carta topo3, si utilizza v.extract: 

 

Vector > Feature selection > Select by attributes [v.extract] 

 

Per estrarre ad es. il tematismo relativo agli edifici, contenuto nella table omonima e connesso tramite il layer 1, nel 

sottopannello Required si inserisca topo3 come carta di input e, ad es., abitazioni.topo3 come carta risultante (il Layer 
number è già 1 di  default nel sottopannello Selection). Quindi Run e Chiudi. 
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La carta risultante ha il seguente aspetto (attivando la visualizzazione delle categorie e dei centroidi). 

 

 
 

Si tenga presente che in tal modo viene creata una carta autonoma, con un proprio file della geometria ed una propria table 

(denominata abitazioni_topo3), visualizzabile tramite 

 

 
 

A questo punto risultano prodotti tutti gli elaborati richiesti, vale a dire:  

1) L'idrografia (in forma vettoriale e con gli elementi privi di categoria) 

2) Un modello altimetrico digitale del terreno (DEM) 

3) Una carta vettoriale contenente contemporaneamente gli edifici, la rete stradale e la vegetazione. 

 

Nell'esercizio, per quanto limitato ad un'area di ridotte dimensioni, si è avuta la possibilità di applicare molte delle funzioni 

più utilizzate disponibili nel VD e di valutare i tempi richiesti dalle operazioni di digitalizzazione e di editing. Inoltre si è 

sperimentata l’acquisizione di carte con caratteristiche diverse: con oggetti privi di attributi (idrografia), con il solo numero 

di categoria (isoipse e punti quotati) e con una table degli attributi associata (edifici, rete stradale e vegetazione). 
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L'utente dovrebbe essere ora in grado di procedere in modo autonomo alla creazione di un database su aree più ampie e con 

un numero più elevato di tematismi. Una valutazione del livello di autonomia acquisito può essere ottenuta ripetendo 

l'esercizio senza l'ausilio del manuale. 

 

 

Formato ASCII di una carta vettoriale 
Per concludere, può risultare interessante analizzare la struttura delle carte vettoriali e le modalità di connessione della 

geometria con gli attributi. Allo scopo, si trasformi la carta topo3 in formato ASCII con: 

 

File > Export vector map > ASCII points or GRASS ASCII vector [v.out.ascii] 

 

Si inserisca nel pannello del comando v.out.ascii il nome topo3 come carta di input e si selezioni Output format: standard. 

In Selection si inserisca -1 in Layer number or name per visualizzare il contenuto di tutti i layers  Quindi Run. 

 

      
 

Nella finestra del Command output vengono elencate, dopo l’intestazione iniziale, le coordinate degli elementi 

digitalizzati contenuti all’interno del file della geometria. La lettera posta all’inizio di ogni sequenza di coppie di coordinate 

identifica il tipo di elemento: B sta per Boundary e C per Centroid (sono anche previste le lettere L per Line, P per Point, 

ma nella carta non sono presenti ne' linee ne' punti). Il numero alla destra della lettera B corrisponde al numero di coppie di 

coordinate (dei vertici e dei nodi) che definiscono l’elemento e che sono elencate al di sotto. Alla destra di C sono invece 

riportati due numeri; il primo è il numero di coppie di coordinate (costantemente 1, essendo un elemento puntiforme) 

mentre il secondo è il numero di connessioni alle diverse table degli attributi tramite i diversi layer. Dopo la coppia di 

coordinate sono riportati nell’ordine il numero del layer e la categoria (fra quelle presenti nella table) assegnati al centroide 

(e quindi all’area all’interno della quale è posto il centroide). Ad es. il centroide riportato nell’immagine sottostante ha un 

solo collegamento, più precisamente al layer 3 (table strade) e alla categoria 2 (Strada campestre).  
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Il centroide della figura seguente ha invece due collegamenti. Il primo alla categoria 3 (Area di pertinenza) della table 1 

(edifici) e il secondo alla categoria 3 (Prato) della table 2 (vegetaz). Se si è eseguita la digitalizzazione dell’area di studio 

seguendo rigorosamente le modalità proposte nella presente sezione, si sarà riconosciuto che il centroide in oggetto è quello 

digitalizzato all’interno dell’area che circonda i due edifici e che è stata assegnata contemporaneamente ai due tematismi.  

 

    

 

 

                                                                    FINE 
 


